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Chapter 1. Overview 

  
iVMS-4200 is a video management software using a distributed structure to provide centralized management to all the 

connectable devices. It can manage the NVR, DVR, IP cameras, and compression cards. With different management and 

configuration modules and a reasonable collocation, it provides many solutions for different surveillance scenario with 

medium or small scale. It is a steady and reliable system with functions like real-time monitoring, video recording and 

searching, file backup, etc. 

This user manual describes the function, configuration and operation steps of iVMS-4200 software. To ensure the properness 

of usage and stability of the software, please refer to the contents below and read the manual carefully before installation and 

operation.  

Chapter 2. Starting iVMS-4200 

 

2.1 User Registration  

For the first time to use the iVMS-4200 software, you need to register a super user for login. 

 

 
 

Enter the super user name, password and confirm the password in the dialog box and click Register. Then, you can log in as 

the super user. 

Note: Enter, Space, and TAB keys are invalid for the user name and password. The password cannot be empty, and it should 

not be less than six characters and can’t be copied and pasted. 

 

2.2 Wizard for Importing Device   

Purpose: 

The main function of the iVMS-4200 is to manage network devices remotely. Thus the task on the top hierarchy is to register 

the device to the management list.  

For the first time user, the wizard message box pops up to ask you whether you want to be guided for the basic operation of 

the client software.   

 



  User Manual --iVMS-4200 v1.02 

4 

 

 
 

 
 

If this is not the first time you use the client software, the wizard doesn’t pop up, and you can also use the wizard, click 

and . 

 

Click to start the wizard, or click to exit the wizard. 

Steps: 

1. According to the hint, click icon to add devices to the management list of the software. 

 

 
 

 

 

2. Create a nickname for the device, enter the IP address and the port number, the user name, and the password of the 
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device.  

3. Click to add the device. 

 
If you add the device with a domain name, you can check the Private Domain Mode checkbox. And create a 

nickname, enter the domain name and port number, and enter the admin name and password of the device to 

add the device. 

 

You can also click  to show the device connected to the same Local Area Network. 

 
Adding the active online devices 

Steps: 

1) Select the device in the device list, and the information of the device such as the MAC address the software 

version and the serial number is shown in the left part. The information in this part can’t be modified. 

2) In the Network information area, you can modify the IP address the Subnet Mask and the Port number with 

entering the admin password of the device. 

3) You can also recover the default password for the device, with the code provided by the authorized engineers. 
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4. Adding Camera Group  

When adding a device, you can check the  checkbox to export the device you added to a certain camera group. By 

default, the name of the group is the same with the name of the device you just added. 

 

 

If you want you customize the camera choosing for the group and the group name. You uncheck the  checkbox and 

click Next page on the Wizard, to enter the adding group interface. 

Click to add a new user. Click Modify to change the settings for the new user. 
 

 

5. Click the on Group dialog box. Edit the name of group and then click to save your settings. The 

added group will be displayed in the list. 

 
 

6. Import Channels to Group  

In the left area on the Camera Import interface, click to select the channels and then click Import button to import the 

selected channels to the Group on the right.  
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You can drag and select multiple channels to import them to the group you added. 

 

Notes: 

 The devices to be added must be online currently. 

 One channel can be added to different groups. 

 Up to 256 groups can be added, and 64 channels can be added to each group, with a maximum of 1024 channels for 

all the groups totally.  

 After importing the selected channels to the group, you can return to the control panel and then enter the Main View 

interface to get a live view of the added channels.      

  

 

 

2.3 User Login  

When you open the iVMS-4200 software after registration, the login dialog box pops up, shown in the following figure:  

 
Input the user name and password, and then click Login.  

Check the checkbox to enable auto-login，and then the user name and password are not needed for the 

login next time. 
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2.4 Control Panel and Main Menu Bar Introduction 

The main control panel of the iVMS-4200 is shown in the following figure:  

 

 
 

Menu Bar: 

 
 

 

File 

 

Open Captured Picture: 

Enter the setting interface to browse the folder in the host PC 

for the exported captured picture file (s) and view the 

captured pictures.  

Open Video File: 

Open the video player and browse the folder location of the 

exported video file (s), click  

 to browse the folder in the host PC of the record files.  

You can also capture pictures when playing of the video file.   

Open Log File: 
Enter the Log File interface to browse the folder in the host 

PC for the exported log file(s). 

Exit: Exit the iVMS-4200 remote client. 

 

 

 

System 

Lock: 
Lock the screen operation. You must log in after locking the 

system. 

Switch User: Switch login user. 

System Configuration: Enter the System Configuration interface. 

Import Configuration 

File: 

Import client configuration file from your PC.  

Export Configuration 

File: 

Export client configuration file to your PC. 

 

 

 

 

View 

1024*768: Display window at size of 1024*768.   

1280*1024: Display window at size of 1280*1024. 

Full Screen: Display window in full screen. 

Control Panel: Enter Control Panel. 

Main View: Enter Main View interface. 

E-map: Enter E-map interface.  

Event Search: Enter Event Search interface.  

 

 

Import Camera Enter Import Camera interface.  

Camera Settings Enter Camera Setting interface.  
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Tools 

Account Management Enter User Account Management interface.  

Device Management Enter Device Management interface.  

Storage Server 

Management 

Enter Storage Server Management interface. 

Stream Media Server 

Management 

Enter Stream Media Server Management interface.  

Broadcast Select device to start broadcasting.  

Device Arming Control Quick setting for arming the device for alarms. 

Help Open Wizard Use the guide for camera import. 

About 
View information of the client software, including company, 

software name, version, etc.   

User Manual (F1) 
Click to open the User Manual; you can also open the User 

Manual by pressing F1 on your keyboard. 

 

 

 

There are 12 icons on the control panel, and their functions are described in the following table: 

 

 

 

 

 

 

 

 

Operating 

Options  

Main View Viewing live video and playback record files and 

other operation (e.g., picture capture, recording, 

PTZ control, etc.). 

E-map Managing and displaying E-Map and hot areas and 

spots; realize E-Map operation (e.g., operate map 

zoom in/out, view hot spot, display alarm, etc.) 

Event Search Searching and playback of the event record files; 

realize playback operation.  

Remote Playback Playback the recorded video and audio composite 

stream or only video files in the remote client. 

Import Camera Adding, modifying or removing the camera 

groups; import/export of cameras. 

Local Log Search Searching, viewing and backup of local logs 

(alarm, operation, system logs). 

 

 

 

 

 

 

 

 

Management 

Options  

Account Management Adding, modifying or removing the user account 

parameters; assign operating permission to each 

user.  

Device Management Adding, modifying or removing the DVR device; 

configuring parameters (e.g., network, alarm 

input/output, HDD, etc.) for the added DVR.  

Storage Server 

Management 

Adding, modifying or removing the storage server; 

configuring parameters (e.g., record schedule, 

network, HDD, etc.) for the added storage server.   

Stream Media Server Adding, modifying or removing the stream media 

server; configuring parameters (e.g., RTSP port, 

upper/lower limit, etc.) for the added stream media 

server. 

 

Configuration 

Options  

Camera Settings 

 

Configuring camera parameters (e.g., image 

quality, record schedule, motion detection, etc.).   

System Configuration Configuring the general parameters (e.g., saving 

path of files, alarm sound, Email, etc.).  

 

  



  User Manual --iVMS-4200 v1.02 

10 

 

2.5 Account Management 

Purpose: 

In the iVMS-4200 client software, many user accounts can be added, and for the different users, different permissions can be 

granted. 

Steps: 

 

1. Click  to enter the account management interface: 

 

 
2. Click  to enter the pop-up Add User dialog box as follows: 

 
User Information: 

User Type: you can select in the drop-down list of the two kinds of user types (Administrator and Operator) to create 

the users with different permissions. 
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 User Name &Password: Customize the login user name and password. 

User Permissions 
There are 27 operating permissions to be selected And the permissions for accessing different cameras are also 

provided.  

Note:The Admin user has all the permissions as default and operator user’s permission should be selected in the list. All 

the selected permissions take effect immediately. 
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Chapter 3. Connecting and Local Management for DVR, NVR 

and Network Cameras  

Before you start: 

Before any operation, you need to add a device and import cameras. There are many ways to add the device in the 

management list. You can add devices follow the guide of wizard. 

Please refer to Section 2.2 Wizard for Importing Device.   

This chapter introduces the connecting and management of the devices.  

3.1 Device Adding in the Device Management Interface 

3.1.1 Adding Device 

Steps: 

1. Click  to enter the device management interface.  

 

2. Click in the Device Management interface. 

 
3. Create a nickname for the device and then input it with other information, the User Name and Password are admin and 

12345 respectively and the port number is 8000 by default. 
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If you check the checkbox, you should enter the DNS address and Device Domain Name as well. 

 
 

The iVMS-4200 also provides the searching the active online devices function. 

Steps: 

1. Click the Show Online Devices icon to search the online devices. All the online devices will be searched and shown on 

the interface.  

2. Click to select the online devices you want to add, and then click to add the device. 

3. Enter the nickname, the user name and the password of the device to add it to the management list. 
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Index shows the numbers of the devices found.  

Added status shows the adding status of the device, if the device is already added in the management list of the software, Yes 

is shown in this list. 

Device type shows the type of the device, whether it is a camera or a DVR and so on. 

Steps: 

1. Select the device in the device list, and the information of the device such as the MAC address the software 

version and the serial number is shown in the left part. The information in this part can’t be modified. 

2. In the Network information area, you can modify the IP address the Subnet Mask and the Port number with 

entering the admin password of the device. 

3. You can also recover the default password for the device, with the code provided by the authorized engineers. 

 

3.1.2 Device Configuration 

After adding the device, you can follow the procedure in this section to configure the device. 

Steps: 

1. Click the device name to select the device in the Device Management interface.  

 

2. You can click  to edit the device basic information as device name and address. 

Or 
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      You also can double click the device to modify it. 

 
 

Click  icon to delete the selected device and you can also configure the settings of the device by clicking 

. For the detailed procedures of remote configuration, please refer to 4.3 Remote Device Management 

and Configuration. 

3.2 Adding a Camera Group 

A camera group must be added for the live view and other operation. After adding the device, please return to the control 

panel interface and click to enter camera group configuration interface.  

Steps: 

1. In the Import Camera interface, click Add to create a group in the right area.  

 

2. Select the camera in the left area, and then click  or to add the cameras to the group. 

You can also hold the Ctrl key and select multiple channels or drag and select the channels to import.  
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3.3 Live View  

Before you start: 

A camera group is required to be defined before live view. For the grouping operation, please refer to chapter 3.2 Adding a 

Camera Group. And the group name is shown in the list on the left bar. 

Entering the Live View Interface: 

Click the main view icon  in the control panel, or click View -> Main View on the toolbar to enter the live view 

interface.  

The main view interface is shown in the following figure: 

 
 

Camera Status: 

 

Icon Description 

 Camera is online and works properly. 

 Camera is offline. 

 Camera is in live view. 

 Camera is in recording status. 

 

Main View Toolbar: 

 
  

Button Name Description 

 
Layout Select different layout modes. 

 
Stop All Stop the display of all the cameras. 

 
Manual Record Start manual record for the selected channel, click again to stop. 

 
Previous and Next Click to view previous and next camera.(Available only when auto-

switch.) 

 
Auto Switch Start auto-switching the screen by cameras or by groups. 
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Volume Adjust the volume for live audio. 

 
Live Audio Enable/disable live audio. 

 

Click , the following box pops up, you can choose the screen layout by clicking the certain icon. 
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3.3.1 Basic Operations in Live View  

Start live view for one channel: 

To view the live video, drag the camera from the list to the display window, or double-click the camera name after you select 

one screen. 
 

 

 
Start live view for camera group: 

You can also get the live view for the whole group and display the live view of all the cameras in the group on the screen.  

Click the group name, and then click the Play button at the bottom of the screen, see the following figure. 

Or  

Double-click the group name. 

 

 
 

 

Stop live view: 

To stop the live view for all the channels, click  on the bottom bar.  

 

Cycle Live View: 

Cycle live view mode includes the auto-switch in one screen or the auto-switch in multi-screen. 

1. Click the  next to the . 

2. Choose the auto-switch mode and set the interval for the switching. 
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3. Click  on the toolbar on the bottom to start the cycle live view. 

 

3.3.2 Capture in Live View  

Steps: 

1. Select the screen. 

2. Click  icon on the bottom toolbar of Main View.  

 
A small window of the captured picture will be displayed to notify you whether the capture is done or not. 

If the capture is successful, there will be a link to the saving path of the picture, and if not, there will be error messages 

accordingly. 

To view the captured pictures: 

 Click the small window of the picture showed on the right bottom after capture. 

 Click the  icon on the left panel; all the pictures captured on the remote client for the selected group are 

stored here. 

 Click File button on the toolbar and select Open Captured File.  
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3.3.3 PTZ Control in Live View 

For the PTZ control, click the  icon on the toolbar on the screen for each camera, and the PTZ control panel will be 

displayed on the left side of the Main View. 

Note: This chapter only shows the operation of the PTZ control, to configure the PTZ parameters see 4.4.8 PTZ   
 

 

 

 
Click on those directional buttons to control the PTZ function, or click the directional buttons on the PTZ control panel. You 

can also control the PTZ direction by the directional buttons on your keyboard. 

 
 

 

You can control PTZ by dragging and clicking the mouse on the display screen window. 
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Use the mouse to click on the video image, and then drag the mouse to different directions by following the arrows displayed 

on the video:  Upper Left;  Up;  Upper Right;  Left;  Right;  Lower Right;  Down;  Lower Right. The PTZ 

will move to the direction as the arrow goes.  

Description of buttons on PTZ Control Panel: 

 

 

Button Description 

 
Zoom 

 
Focus 

 
Iris 

 
3D Positioning  

 
Light 

 
Wiper 

 

Direction buttons, click  to start/stop auto-scan. 

 
Speed adjustment for PT function 

 
Preset configuration 

 
Pattern configuration 

 
Patrol configuration 

 Calling function 

 
Adding and editing function  

 
Deleting  

 

Preset Configuration 
To add a preset for the PTZ: 

Steps: 

1. Click the direction buttons to move the PTZ to a desired location,  

2. Select a PTZ preset number from the preset list, and then click  to add the preset and name this PTZ preset.  

To delete a preset, select the PTZ preset from the preset list, and then click  to remove it. 

 
 

Pattern Configuration 
To add a pattern for the PTZ,  

Steps: 

1. Click the  button to enter the PTZ pattern path setup panel. 
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2. Select a PTZ pattern path number from the pattern list, click  to enter edit mode.  

3. Click  to start recording of this pattern path.  

4. Use the direction buttons to control the PTZ movement.  

5. Click  to stop the pattern recording. Click  to save the pattern path. 

    
Patrol Configuration 
After adding two or more presets for one channel, you can set a patrol with presets for PTZ.  

To add a patrol path for the PTZ: 

Steps: 

1. Click  button to enter the PTZ patrol path setup panel. 

2. Select a track number from the list. 

3. Click  to add a preset (including the dwell time and PTZ speed for the preset) for this patrol path. 

 

Repeat the above operation to add other presets to the patrol.  
 

4. Click  to call the patrol path or click   to stop calling.  

5. Click  to edit a preset in the patrol path.  
Notes:  

 Up to 16 patrols can be configured.  

 The patrol time can be set to 1~255 sec, and the patrol speed to level 1~40. 
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3.4 Alarm and Event in Live View 

3.4.1 View Alarm /Event Information  

The Main View interface provides the  buttons at the left bottom toolbar.  

 

Click the button to view the alarm or event information as shown in the panel.  

You can click  icon to lock the toolbar and show the information in the main view. Or click  to hide the list.  

 

 

Click  icon to maximize the alarm/event log display panel and enable it to be shown in a new tab page.  
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As shown in the figure above, in the alarm log display panel, there are 4 different alarm types: “Motion”, “Video Abnormal”, 

“Alarm Input” and “Device Abnormal”.  

Check the checkbox to show the alarm of the type. 

 

You can select a log and right-click it to remove it from the list or right-clicking the mouse and then click . 

 

3.4.2 Alarm Log Linkage   

Each alarm log shows the related alarm information, including occurred time, source and type of the alarm.  

You can click the   or   button to preview or send email of the selected alarm information and video.  

 

 Live View: View the live video of the selected alarm source camera.  

 Send Email: Send the alarm information by Email.  

Note: You need to configure Email settings in Control PanelSystem ConfigurationEmail before using this function.   

 

3.4.3 Block the Alarm from Certain Device 

Purpose:  

Sometimes, the blocking of the alarm information from certain device is needed. This is especially useful when you use 

more than one client to manage many devices. 

 

Steps: 
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1. Click  on the menu bar. 

 

2. Click to enter the alarm enable or disable interface. 

 

 

 

 

3. Check the checkbox to enable the alarm or uncheck it to block the alarm information. There are tabs to list 

different kind of connected devices. 

4. Click  to confirm your settings. 

Note: This function only blocks the selected alarm information from being received by this client only; the alarm 

information can also be received by other clients. And when you block the alarm information from certain devices, all 

the alarm information is not shown in the client and all the linkage methods in the client such as the audible warning, 

pop-up image, and email sending are not taken as well.  
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3.5 Local Recording and Capture 

iVMS-4200 software provides the local recording and remote recording.  

Local recording refers that you record the video from the remote device in the local PC runs the iVMS-4200 software. Local 

recording for the iVMS-4200 can only be manual recording, and the schedule recording is not valid. 

The remote recording refers to the remote control of the device in the management list to record on the HDD of the device 

side.  

 

3.5.1 Recording and Picture Capturing on the host PC for the iVMS-4200 

Local Recording (also called Manual Recording) function allows you to record the live video in the Main View mode.  And 

the record file is recorded in your PC. 

Steps: 

1. In the main view interface, select a channel in the group and double-click it to view the live video. 

2. Then click  button at the bottom of main view panel to start to record the live video. 

3. To stop recording, please re-click  button. A prompt box with the saving path of the video files you just 

recorded will pop up if all the operations succeed. 

 

To change the saving path of the record files and captured pictures, go to the files configuration interface; see 7.2 

File Saving Path Configuration for detailed information. 

 
 

Quick View the Manual Recording File:  

You can open the folders to find the record file, or you can click All File(s) icon to show the record files in the 

iVMS-4200.  
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You can double-click the record file to play it. For detailed information, see 3.6.1 Playback of Local Stored Files. 

 
To manual capture in the live view, see 3.3.2 Capture in Live View. 

 
 

3.6 Local Playback 

Based on the different recording modes, there are two playback modes: Local playback and remote playback. 

3.6.1 Playback of Local Stored Files  

Play back the video files created in local recording mode which is restored in your PC. 

Steps: 

1. Go to Main View panel and click the All File(s) icon to enter the Local Record Files interface. Select a camera and 

specify the start time and the stop time, and then click Search button to search the video clips. The matched video found 

will be listed in the display panel below.  
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2. Double click the record file to play it back. 

 

 

You can click  button to save as the selected record file. You can click  to delete the clip from the panel, or click 

the  button to send the selected video clip by Email (The size of video clip must be less than 5M). 

Note: To send the record file to an Email address, you must configure Email settings. For detailed instruction, see 7.4 

Email Configuration. 

 

3.6.2 Instant Playback 

1. Go to Main View panel, left-click a channel to enable the menu shown as follows, and click  button to start instant 



  User Manual --iVMS-4200 v1.02 

29 

 

playback. 

 
 

2. In instant playback interface, please click  button to start playback the first video files of current day; click  

and  buttons to fast forward or slow forward. And you can also left-click on the playback panel to show the menu 

with multiple playback function. 

 

 

3. You may also use the timeline at the bottom of the Main View panel to adjust the playback progress. And the tag you 

just added is shown as a flag icon on the progress bar. 

 

 

 

3.7 Managing E-map  

Relating certain camera group to an E-map allows you to visualize the location and distribution of cameras. The E-map is 

beneficial especially when alarm is triggered.  

3.7.1 Adding an E-map 

For the first time to use E-map function, you are required to add a map first.  

Click View->E-map View on the menu bar or click  on the Control Panel to enter the main interface of E-map. Refer to 

the following figure:   

 

Note: Only one map can be added for each camera group. 

 

Steps: 

1. Click  to add a map related to the camera group. 
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2. Click  to browse the directory where the map is stored. 
Note: The picture format of the map should be *png, *jpg or *bmp. 

 

 
 

 

3. Enter a name of the map. 

 
 

4. Click  to confirm your selection. 

 

After adding map successfully, it shows on the window and name of map also appears on the list of group. 
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3.7.2 The Hot Spot Function 

You can add the camera label in the map to show the location of the camera. The label is called hot spot. And with the hot 

spots added the cameras are linked to the map, in the map preview interface, you can see the live view of the camera and if 

there is an alarm triggered, icon  appears near the camera label.  
 

Adding a hot spot: 

 
 

Steps: 

1) Click  and select which camera you want to add on the map as a hot spot, and choose the color of the hot spot. 

 

 

Map view adjusting 
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2) Check the checkbox of the camera name to select them as the hotspots. 

        You can choose many cameras at the same time.  

 

3) You can choose the hot spots label color in this interface.  

 

 

       After being added as a hot spot, the camera icon in the camera list change to . 

 

 
4) Drag the camera icon to certain location on the map. 

 

Editing the hot spot: 

Double-click the hot spots icon on the map to modify the hot spot name and the color of it. 

Or 

Right-click the hot spot and choose Modify. 

 
Or 

Select a hot spot on the screen and click the  icon on the toolbar. 



  User Manual --iVMS-4200 v1.02 

33 

 

 
 

Deleting the hot spot: 

Right click on the hot spot and choose delete. 

Or  

Select a hot spot on the map and click  on the toolbar to delete the hot spot. 

 
Previewing the map with the hot spot： 

After all the settings are done for the hot spots, click  on the toolbar to see the E-map. The hot spots are 

distributed on the map to show the location of the linked cameras. 
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Double-click the hot spot, the live view of the camera is shown in the interface. 

 

If an alarm is reported from certain cameras, the  icon shows in the map to alert you. 

 
For the detailed alarm information, double click the alarm icon. 

 

You can click the  icon to clear all the alarm information. 
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3.7.3 The Hot Region Function 

The hot region function links a map to another map. When you add a map to another map as a hot region, an icon of the link 

to the added map is shown on the map.  And the added map is called child map while the map to which you add the hot 

region is the parent map. 

Note: A map can only be added as the hot region for one time. 

Steps: 

1. Click  in the toolbar. 

 
 

2. In the message box, select the map you want to add as a hot region. And you can also select the color of the map 

icon. 

 
3. Drag the map icon on the map to certain location. 

 
4. You can double-click the map icon to modify the map name and the icon color. 

5. You can click  on the toolbar to modify it. 

Or you can right-click the icon and choose  to modify it. 
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To delete the hot region: 

Select the hot region icon on the map and click the  to delete the hot region. 

Or  

Right-click the hot region icon and choose Delete. 

 

Map Previewing with the Hot Region: 
After the successful adding and setting of the hot region, go back to the map preview interface. 

 

 

 
Clicking the hot region icon now can take you to the child map. 
 

 

 

 

Click the  to go back to the parent map. 
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Chapter 4. Remote Control and Management for DVR, NVR and 

Network Cameras  

Remote control and management means that you operate the iVMS-4200 software to control the devices, such as control the 

device to record, to capture, to change parameters and reboot. And you can also get the record files stored in the HDD of the 

device. 

4.1 Remote Recording 

When the video storage devices are HDDs, NetHDDs or SD/SDHC cards installed in the DVR, NVR or IP cameras, or when 

you have a storage server connected you can configure the recording of via the iVMS-4200. 

4.1.1 Recording on the Storage Device on the DVR, NVR or Network Camera 

Before you start: 

For the newly installed storage devices, you need to initialize them. 

Note: This is not a mandatory procedure. If the storage devices are already in use, and some record files are recorded on it, 

the initialization operation should be considered carefully. If the initialization is not needed, start your setting with step 4. 

Steps: 

1. Format the HDD or SD/SDHC card: After adding the devices into iVMS-4200, enter the 

interface of the selected device. 

2. Click HDD sub-menu to format the storage devices first, shown in the figure below. 

 

3. Click  to format the HDD installed in the device. And the process bar shows the formatting process 

of the HDD. 
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4. Enable Local Recording: Go to Camera Settings > Schedule and check the checkbox of the Local 

Recording.  

Note: In this interface, the Local Recording refers to the recording on the HDD of the DVR or IP Camera. 

 

 

 

 
   

5. Recording Schedule Configuration: click icon and configure the schedule template shown below:  
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 for all-day continuous recording 

 

 for working-hours continuous recording from 8:00 AM to 8:00 PM; 

 

 for all-day event recording.  
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6. Editing the recording schedule template: 

1) Click . 

 
2) You can edit the template name and time schedule in this interface. 

 

 means normal scheduled recording. The schedule time bar is blue. 

 means schedule recording for events. The schedule time bar is yellow. 

 means schedule recording triggered by command. The schedule time bar is green. 

Note: Command recording function is only available when iVMS-4200 added ATM DVR while the ATM transactions are 

taking place. 

 

When the cursor turns to , you can edit the schedule. 

When the cursor turns to , you can move the schedule you just configured. 

When the cursor turns to ，you can lengthen or shorten the time bar you configured. 

7. Click  to save the schedule you just set. 

 

The configuration of the capture schedule is the same with that of the record schedule. 

 

Click  in the schedule interface to set the Pre-record time, Post-record time and the storage parameters 

for the record files. 
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Pre-record: Normally used for the event triggered record, when you want to record before the event happens. 

Post-record: After the event finished, the video can also be recorded for a certain time. 

Video Expired Time: The time for keeping the record files in the HDD, once exceeded, the file is deleted. 
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4.1.2 Recording on the Storage Server 

Using iVMS-4200 software, you can configure the recording schedule for any added channels and store the recorded files in 

the NVR storage server.  

The storage server can be configured for recording the video files. And the storage server application software is also packed 

in the iVMS-4200 software package.  

Adding and configuring the storage server 

Steps: 

1. Click  button in the control panel of iVMS-4200, and then click  button to add the storage server. 

2. Create a nickname for the storage device and input other information.  

The IP address should be the IP address of the PC on which the storage server runs. 

 

 

3. Click  button and go to  sub-menu and select a local HDD in the server for storing 

recorded files, then click   button to format the HDD, shown as figure below:  

 
And in this interface you can also configure the network parameters, the user information, the exception handling 

method and so on. 
Setting storage server recording schedule  

Steps: 

1. Add Recording Channels: Click  button to enter the interface to choose the camera and add the 

record file to the storage server. 
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2. Click  and the following message box pops up. 

 
3. Check the checkbox to select the cameras for which you want to record on the storage server. And then 

click  to confirm your selection. 
4. Set Recording Schedule: click Schedule on the left to enter schedule configuration interface. 

 
 

5. Select the camera from the dropdown list, then click icon and configure the schedule template shown as 

below:  
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 for all-day continuous recording 

 

 for working-hours continuous recording from 8:00 AM to 8:00 PM; 

 

 for all-day event recording.  
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Editing the recording schedule template: 

Click . 

 
You can edit the template name and time schedule in this interface. 

 

 means normal scheduled recording. The schedule time bar is blue. 

 means schedule recording for events. The schedule time bar is yellow. 

 means schedule recording triggered by command. The schedule time bar is green. 

When the cursor turns to , you can edit the schedule. 

When the cursor turns to , you can move the schedule you just configured. 

When the cursor turns to ，you can lengthen or shorten the time bar you configured. 

Click  to save the schedule you just set. 

The configuration of the capture schedule is the same with that of the record schedule. 

 

Note:  

If you want to change recording resolution, bit rate or other recording parameters, please click Image Quality button in the 

Camera Settings panel and modify the main stream quality as needed.  

To ensure that event recording works properly, please set motion detection   &video tampering area, schedule/alarm schedule 

first and then enable trigger camera recording. More details in Camera Settings Chapter. 

Command recording function is only available when iVMS-4200 added ATM DVR while the ATM transactions are taking 

place. 
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4.2 Remote Playback 

The remote client can search the record files on the Storage Server and the DVR, and it can also do the smart search for the 

event triggered record files during playback. 

Click  in the control panel to enter the Remote Playback Interface. 

 

 

 
Toolbar Description: 

Icon Name Description 

 

Screen Split 1, 4, 9, 16 screen-mode 

 

Stop Stop all the playback video. 

 

Volume Adjust volume 

 

Full-screen Full-screen Preview 

 

Record file searching: 

1. Searching for all the files: 

Check the checkbox on the camera list, and then on the calendar below, select the day you want to search. Then click Search. 

 
 

Note: If there are record files for that camera in that day, in the calendar, the icon for that day is displayed as . Otherwise it 

is displayed as . 

The timeline indicates the time duration for the record file. 
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2. Searching by card number: 

Note: This function is only applied to the ATM DVR, you can search the record files by the DVR card number. 

 
Note: You still need to choose the date and camera to search the files. 

3. Searching by File Type: 

You can select the file type to restrict the searching condition and search for only the record files for certain types.  

 
Playback management: 

1. Left-click the mouse on the screen of which camera you’d like to manage. A toolbar is showed at the bottom. 

 

Toolbar description: 

Icon Description 

 

Pause the video 

 

Stop playing 

 

Playback by single frame 

 

Smart Search (Only for the devices with the smart search function) 

 

Clip the record file 

 

Audio on/off 

 

Play 

 

Speed Control 

 

Digital Zoom 

 

Capture in the playback mode. 

 

Download 

Note: Click , and the video move forward to next frame. 

You can enable audio on only one channel at one time. 

 

Smart search management: 

Click  on the left-click toolbar, and the smart toolbar is showed up. 

 

Note: The smart search function should be supported by the remote devices you connected. Now the function is applied to 

9000 or 9100 series or above version DVR. 

Click  to draw the smart search area and click  to start the smart search. 

Toolbar Description: 

Icons Description  Icons Description 

 

Draw Area  
 

All Area 

 

Delete Area  1 2 3 Sensitivity of Event 

 

Start Searching  
 

Last Event 

 

Next Event  
 

Close 

 

If there are eligible record files for smart search, there are red areas on the time line. 

 
 

Download record files: 

Click  to download the files you selected. 
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Note: The saving path for the downloaded files can be set in the System Configuration interface.  See Chapter 7.2 File 

Saving Path Configuration. 

Event playback 

Play back the record files of event type. 

1. Go to Event Search interface and select an event type: motion or alarm input. 

 

 

  
 

2. Select a camera in the group and specify a start time, and then click  button. 

3. Select a window, and double-click a video file from the search results list to play. 

Note:  

 Event playback function is only available for NVR/DVR which support event recording. 

 Make sure to import all the channels that you wish to play back in Import Camera panel. 

 It is also required to enable continuous recording on all the alarm/motion-triggered channels before event playback. 

 

4.3 Remote Device Management and Configuration 

The remote configuration and management for the connected devices are provided. You can configure the parameters for the 

basic settings, the image and the network transmission of the device.  

Note: For different devices the remote configuration interface are different. In this section, we take the remote configuration 

interface of the DS-9000HFI-ST DVR as an example. 
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Steps: 

1. Click icon on control panel to enter device management interface.  

2. Select the device you want to configure, and click  button to enter the device management 

interface. You can also enter the device management interface by clicking the Remote Configuration  button in 

Import Camera interface. 
 

 

 

4.3.1 Basic Information 

On the Information page, you can check the basic information of the device, including device type, total channel number, 

HDD number, physical Alarm I/O number, Device Serial Number, and version information.  
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4.3.2 General Settings 

On the general settings page, you can set the basic parameters of the device. 

 
Table. General Parameter Descriptions 

Parameter Description 

Device Name 
Define the name of the device, and it will be displayed on the device 

list of the client 

Device No. Device number for remote control 

Record Replace Overwrite HDDs when HDDs are full 

Main BNC Scaling Scale image display on the main BNC output 

Spot BNC Scaling Scale image display on the spot BNC output 
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4.3.3 Camera Management 

If the managed device is a DVR/NVR with multiple cameras connected, you can find the camera management page. You can 

enable and disable the analog cameras and add, change, and delete the IP cameras in this interface.  

 

4.3.4 Network Settings 

On the network settings page, you can configure network parameters of the device. Two tabs are available for general and 

advanced settings.  

 
 

Table. General Network Settings Descriptions 

Parameter Description 

Working Mode Set working mode as Net Fault-tolerance, Load Balance or Dual-NIC 
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Settings for DVRs/NVRs (Only available for the devices with dual-

NIC interface) 

NIC Type NIC types of the device 

Device IP Address IP address of the device 

Subnet Mask Sub net mask IP for the device 

Gateway Default gateway IP for the device 

MAC Address Mac address of the device; this is a read-only field 

MTU(Byte) The maximum transport unit; the default value is 1500 

Device Port Network port of the device, the default port number is 8000 

Multicast Address 
Multicast address of the device. Please leave this field empty if 

multicast is not required 

HTTP Port Web servicer port; the default port number is 80 

Main NIC 
Set the main NIC for DVRs/NVRs.(Only applicable for the devices 

with dual-NIC interface) 

RTSP Port Real time streaming protocol port; the default port is 554 

 
Table. Advanced Network Settings Descriptions 

Parameter Description 

NTP Set server, port, interval and time for NTP time synchronization.  

Email Email account settings for the device 

PPPOE Set DDNS address, username and password for PPPOE 

DDNS Set protocol type, server, port, account and domain for DDNS 

Advanced Settings Configure DNS server addresses, alarm host IPs and ports. 

Wifi Configure wireless networking related parameters 

SNMP Set SNMP version, read/write community and trap address.  

Note: You can click each Set button for the advanced settings.  

4.3.5 Alarm Settings 

On the alarm parameter page, you can configure alarm I/O and linkage actions for the device. 
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Alarm input parameters description 

Parameter Description 

Alarm Input Select an alarm input channel for configuration 

IP Address 
IP address of the digital alarm input. “Local” stands for the hard-

wired alarm input interface on the device. This is a read-only field. 

Alarm Name Define a name for the alarm input channel 

Alarm Status 
“Normal Open” stands for normally open status and “Normal Closed” 

stands for normally closed status. 

Handling Check the checkbox to activate alarm linked action settings 

Arming Schedule 

Set the time schedule to handle the alarm triggered actions. The 

schedule template can be configured in Schedule settings page of 

Camera Settings.  

Linkage 

Check the alarm actions which are required to be activated when the 

alarm input triggered, and select corresponding channel number if 

required.   

 

Alarm Output Parameter Descriptions 

Parameter Description 

Alarm Output Select an alarm output channel for configuration 

IP Address 
IP address of the digital alarm output. “Local” stands for the hard-

wired alarm input interface on the device. This is a read-only field. 

Output Delay Select the delay duration for the alarm output 

Arming Schedule 
Set the time schedule to handle the alarm output. The schedule 

template can be configured in Schedule settings page of Camera 
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Settings. (Please refer to Section 5.4.3 for details) 

Linkage 

Check the alarm actions which are required to be activated when 

the alarm input triggered, and select corresponding channel 

number if required.   

4.3.6 User Management 

Purpose: 

You can also add or delete users for the connected device.  

In the user management page, you can create/delete user accounts and configure permissions for each user account. 

 
To add a user account:  
Steps: 

1. Click the Add icon on user management interface. 

2. Choose user type (Guest/Operator), enter username and password. 

3. Grant the account privileges to this device.  

4. Click Confirm to finish.   

The created user accounts will be listed in the user list with basic information. 
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4.3.7 HDD Settings  

On the HDD settings page, all the HDD installed on the device are listed with basic information. You can configure network 

disk, HDD groups ,modify the information or format the disks. 

 

4.3.8 Exception Settings  

In exception settings interface, you can select the exception type, and check the linkage actions accordingly under Alarm 

Triggering Mode section and select the channel number in Alarm Output section. Different linkage actions can be configured 

for different exception type.  
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4.3.9 File Management  

On the file management page, you can search and view the record files of the device. Select the camera number, file property 

(all, locked, or unlocked), define the start and end time of the record files, and then click Search. The matched record files 

will be listed accordingly.  

 
If the device supports remote backup function, you can also select files and click Backup to back up all the selected record 

files. 
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Captured pictures and record files stored on local devices can also be searched, played back and backed up. Picture types 

include motion detection, alarm, continuous capture and etc. 

4.3.10 Log Management 

You can query log files of the connected device in log management interface. Select the search mode, major type and minor 

type, define the start and end time of the log files, and then click Search. The log will be listed accordingly. 

 
If the device supports remote backup function, you can also select logs and click Backup to back up all the selected log files 
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4.3.11 Holiday Settings 

Note: This chapter is only for the remote device with holiday schedule function.  
In the holiday setting interface, you can check the holiday settings and edit the holiday schedule. 

 
To edit the holiday schedule, click the Edit icon, set the start and end time for the holiday and click Confirm.  

 

4.3.12 Other Settings (RS-232 Settings, Remote Upgrade and DST Settings) 

In this interface, you can set the RS232 information and remotely upgrade the device.  
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For remote upgrade function, click  button to browse and select the upgrade file, and click Upgrade to start upgrading. 

The upgrade process will be displayed and a reboot is required when it’s finished. 

 

To enable the DST function, click the button and enable DST. 
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4.3.13 Channel-zero Settings 

Channel-zero is a feature designed for DVRs/NVRs to decrease the required bandwidth when remotely viewing several 

channels at a time by web browser or remote client software.  

Note: This function must be supported by the device connected. 

 

On this page, you can enable/disable channel-zero coding, set the encoding parameters(max bitrate and frame rate), 

screening-split settings (working mode and switching intervals) and camera order for displaying.  

Note: The Max. Bitrate and Frame Rate should be set according to the real network condition. 
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4.3.14 Resource Usage 

The resource usage tab is only valid for some DVRs or NVRs.  

In this interface, you find the network resource usage status, including preview, playback and IPC module.   

 
 

4.4 Camera Settings 

Steps: 

1. Click Camera Settings icon on control panel to enter the camera setting interface.  
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2. Select a camera from the dropdown list in the upper left corner of the interface. The live image of the camera will be 

displayed on the screen below.  

3. Click the icons in the bottom left area to enter each configuration pages. You can also click Device Settings icon to 

manage the device. Please refer to section 4.3 for Device Management. 

Description of the Camera Setting interface: 

Icons Description 

 
Set camera parameters of the device 

 

Set image quality, resolution and other encoding 

parameters of the camera 

 
Set recording schedule of the camera 

 

Set camera display parameter. E.g. OSD and privacy 

area 

 
Set motion detection parameters of the camera 

 
Set tampering alarm parameters of the camera 

 

Set video loss alarm parameters of the camera. E.g. 

arming schedule, linkage mode, and etc. 

 
Set PTZ parameters. E.g. baud rate, protocol and etc.  

 
Set connection parameters of the camera 
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4.4.1 Picture Settings 

The quality of the picture can be configured in the picture settings interface. You can adjust the brightness, contrast, 

saturation and hue of the video image.  

 

 

 
Click the Advanced Settings icon to configure parameters below. 

 

Picture Advanced Setting Descriptions 

Parameter Description 

Video Settings 
Configure the brightness, contrast, saturation, hue, sharpness and 

AGC for the video.  

White Balance  Configure the white balance. 

Exposure Configure the exposure time and iris type (auto/manual) 

Day/Night Switch Configure the day/night mode and define the filtering time.  
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Others 
Configure parameters including flicker filter, mirror, PTZ and local 

output. 

4.4.2 Video Quality 

 

 

 
On this page, you can configure parameters for main stream and sub-stream separately. You can set video quality and 

resolution on the main interface. To configure steam type, bitrate type, max bitrate, frame rate, frame type, frame interval and 

encoding type, please click Advanced Settings button to enter advanced setting interface.  

 

Click  icon, you can copy the settings to other cameras within the same group. 
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For the direct connected IP cameras, the audio parameters can also be set. Choose the audio encoding type and the audio 

input type. You can choose mic in for using the microphone as the audio input and choose the line in for using pickup. 

 
 

4.4.3 Record Schedule 

You can set recording schedules parameters to enable the automatic recording in certain time duration.  

Note: Parameters in the Record section are set for the camera you’ve selected. For Storage Server Recording 

parameters, you need to add a storage server first. To assign an Storage Server for the recording schedule, please click 

Storage Server button. 

. 

 

 

 



  User Manual --iVMS-4200 v1.02 

66 

 

 
You can follow below steps to set the record schedule templates.  

1. Click the template selection button of Record Schedule to enter template configuration interface. 

2. You can choose pre-designed All-day Template, Weekday Template or Alarm Template, or customize your own record 

template. 

3. Choose one of undefined templates or click Customized to activate the edit mode. Click Schedule Recording, Event 

Recording or Command for different recording types. Drag the mouse on the time bar to define the record time window 

for each day.  

 

4. Click the colored bar to display the specific time schedule. You can also shorten or extend the time window by amending 

the length of the bar.  

For more details of record schedule, please refer to the table below.  

Record Schedule 

Icons Description 

 
Delete the selected schedule 

 
Clear all the record schedules of the selected template 
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Copy the selected schedule section to other day (s) 

 

Normal scheduled recording. The schedule time bar is blue. 

 

Schedule recording for events. The schedule time bar is yellow 

 

Schedule recording triggered by commands. The schedule time bar is green. 

(Only available for ATM DVR.) 

You can also click  icon to copy the settings to other cameras within the same group. 

 

4.4.4 Video Display 

On the video display page, you can define the following parameters for the camera.  

 

 

 
Video Display Parameters 

Parameter Description 

Display Name The camera name displayed on the live video 

Display Date  
Display the date on the live video and choose the date format and 

time format  

Display week Display the week on the live video. 

Enable Privacy Mask 
Enable privacy mask function on the live video. You can drag the 

mouse of the live video to set the mask.  

Text Overlay Edit user-defined text to be displayed on the live video. 

You can set privacy masks, configure OSD and define the text locations on the live video. Please follow steps below to 

enable the functions.  

To draw a privacy mask: 

1. Check the Enable Privacy Mask checkbox.  
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2. Drag the mouse to draw a square on the live video. You can move it to change the location or change the size by 

enlarging or reducing the area. 

 

 

3. You can also click  Delete or Delete All icon under the view to delete the privacy mask.  

4. Click to finish.  

To configure the OSD and text: 

1. To define the text overlay, check one of the text checkboxes and enter the content. Click . You can see the 

text shown in the left upper corner of the live view area. 

2. Drag the mouse to move the OSD or the defined text window to change the location on the live video.  

 

3. Click .  

Note: You can configure up to 4 privacy masks.  

4.4.5 Motion Detection  

You can configure motion detection parameters in Motion Detection interface.  
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Steps: 

1. Check Enable Motion Detection checkbox to enable the function. 

2. Draw the detection area on the video image by dragging the mouse and set the sensitivity on the value bar under the live 

view.  

3. You can click the  icon to set the whole video area as detection area; click the  icon to delete the selected 

detection area; or click the  icon to delete all the motion detection areas. 

4. Click the template selection button of Arming Schedule to setup the schedule for motion detection. The steps are similar 

to record schedule configuration. You can refer to section 5.4.3 for more information. 

5. Configure linkage methods for motion detection. Please refer to Table 9.4 for linkage method details.  

6. Click  to save the changes.  

Linkage Method for Motion Detection 

Parameter Description 

Audible Warning 
Trigger audible warning on the device when motion detection is 

triggered. 

Notify Surveillance Center 
Upload alarm information to the CMS software when motion 

detection is triggered. 

Trigger Alarm Output 

Activate one or multiple channels of alarm output when motion 

detection is triggered. Users need to specify the corresponding alarm 

output channel (s) in Alarm Output Settings. Please refer to section 

9.2.5 for Alarm Settings 

Email Linkage 
Send out an Email when motion detection is triggered. Please refer to 

section 9.2.4 for emails parameter settings 

Full Screen Monitoring 
Switch to full screen to monitor the motion detection video when 

motion detection is triggered.  
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4.4.6 Tampering Alarm 

Purpose: 

Tampering Alarm is an alarm triggered when the camera is covered and the monitored area can’t be seen. You can configure 

tempering alarm parameters in this interface.  

 

 

 
Steps: 

1. Check Enable Tampering Alarm checkbox to enable the function. 

2. Draw the tampering detection area on the video image by dragging the mouse and set the sensitivity on the value bar 

under the live view.  

3. You can click the  icon to set the whole video area as detection area and click the  icon to delete the selected 

detection area. 

4. Click the template selection button of Arming Schedule to setup the schedule for tempering alarm. The steps are similar 

to record schedule configuration. You can refer to section 5.4.3 for more information. 

5. Configure linkage methods for tampering alarm. Please refer to Table 9.5 for linkage method details.  

6. Click  to save the changes.  

Linkage Method for Tampering Alarm 

Parameter Description 

Audible Warning Trigger audible warning on the device when alarm is triggered. 

Notify Surveillance Center 
Upload alarm information to the remote management software when 

alarm is triggered. 

Trigger Alarm Output 

Activate one or multiple channels of alarm output when alarm is 

triggered. You need to specify the corresponding alarm output 

channel (s) in Alarm Output Settings.  

Email Linkage 
Send out an Email when tampering alarm is triggered. Please refer to 

section 8.4 for emails parameter settings. 

Full Screen Monitoring Switch to full screen to monitor video when alarm is triggered.  
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4.4.7 Video Loss Detection 

Video Loss detection is used to detect the disconnection of the channels. You can configure video loss alarm parameters of 

the camera in Video Loss interface. 

 

 

 
Steps: 

1. Check Enable Video Loss Detection checkbox to enable the function. 

2. Click the template selection button of Arming Schedule to setup the schedule for video loss detection. The steps are 

similar to record schedule configuration. You can refer to section 5.4.3 for more information. 

3. Configure linkage methods for video loss detection. Please refer to Table 9.6 for linkage method details.  

4. Click  to save the changes.  

Linkage Method for Video Loss Detection 

Parameter Description 

Audible Warning Trigger audible warning on the device when alarm is triggered. 

Notify Surveillance Center 
Upload alarm information to the CMS software when alarm is 

triggered. 

Trigger Alarm Output 

Activate one or multiple channels of alarm output when alarm is 

triggered. Users need to specify the corresponding alarm output 

channel (s) in Alarm Output Settings. Please refer to section 9.2.5 

for Alarm Settings 

Email Linkage Send out an Email when tampering alarm is triggered.  

Full Screen Monitoring Switch to full screen to monitor video when alarm is triggered.  



  User Manual --iVMS-4200 v1.02 

72 

 

4.4.8 PTZ Parameters Settings 

On the PTZ parameters configuration page, you can specify the PTZ connection parameters, such as baud rate, data bit, stop 

bits, parity, flow control, PTZ protocol and PTZ address.  

 
Note: The PTZ parameters should be consistent with the settings of the PTZ on the DVR or IP camera side to ensure valid 

PTZ control. 

Click to save the changes, you can also click  icon to copy the settings to other cameras within 

the same group. 

4.4.9 Configuring Network Connection 

On the Network Connection configuration page, you can specify the protocol, choose the stream type of the camera, and 

configure stream media server.  

 

To configure the steam media server, check Obtain Video Stream via Stream Media Server checkbox . 

For the detailed configuration of the stream media server, see chapter 5.1 Adding a Stream Media Server. 

Click to save the changes, you can also click  icon to copy the settings to other cameras within 

the same group. 
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Chapter 5. Forwarding Video Stream from Stream Media Server 

5.1 Adding a Stream Media Server 

When there are too many users want to get a remote access to the devices to get the live view or management, you can add 

the stream media server and get the video data stream from the stream media server, thus lower the load of the device. 

Steps: 

1. Click  to enter the Stream Media Server configuration interface. 

 

 
 

2. Click , the dialog box pops up. 

 

 
 

3. Create a nick Name, enter IP address of the PC on which the stream media server is running, and Port number (the Port 

554 is the default RTSP port number), and then click Add to save it. 

Note: When you install the iVMS-4200, you can install the stream media server in your computer too, you can also run the 

stream media server on the same computer on which you run the iVMS-4200. 
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5.2 Forwarding Video Stream via the Stream Media Server  

Click to configure the stream media server you selected. 

 The Port Config tab: 

  

 
The RTSP Listening port is 554 by default. 

The maximum and minimum value of the port pool is 13000 and 12000 respectively.  

In the Channel Config. tab, you can select and choose the device which you want to add to the stream media server and get 

stream form the media server. 

 The Channel Config. tab: 

 
1. Select the camera group which you want to add to the stream media server. 

2. Choose the cameras to add by check the checkbox or check the  to add all the cameras in the group to the 

stream media server. 

3. Click  to confirm the settings you made. 

After the successful configuration, you can get the data stream from the device via the forwarding of the stream media server. 
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Chapter 6. Log Management 

Purpose: 
This chapter explains how to search and backup system logs and open saved local log files in the client.  

To enter local log management interface, click Local Log Search icon on control panel.  

6.1 Local Log Search 

Steps:  

1. Set “Log Type”, “Minor Type’, ”User Name”, “Group”, “Camera” and the time window of the log you intend to search.  

2. Click “Search” button. 

The matched logs will be listed on the display pane. 

 

 

 

6.2 Log Backup  

Steps:  

1. After searched the logs, click “Backup” button. 

2. Click  button to select the saving path on the “Backup Log” dialog box, and define the file name. Click 

and “Backup” buttons.  
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6.3 Opening Log Files  

For the log files that have been backed up to local PC, you can open them in this interface for management purpose. 

Steps:  

1. Navigate to File→ Open Log File from the menu bar. 

 

2. Click  button to browse the folders where the log files are located.  

3. After selecting the log file, click  to open the log file.  
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Chapter 7. System Configuration 

Purpose: 

This chapter includes instructions of general configuration, file saving path configuration, alarm sounds and email 

configurations for the system. Click “System Configuration” icon on control panel to enter system configuration interface.  

7.1 General Configuration 

On the General configuration page, you can configure the general settings for the local system. 

 
 

Parameter Description 

Log Keeping Time The expiration time of the system logs.  

View Scale It can be set as Full Screen, 4:3 or 16:9. 

Instant Playback Time It can be set as 30s, 1min, 3min, 5min or 10min 

Network Performance It can be set as low, middle, or high. 

CPU Performance It can be set as low, middle, or high. 

Enable Auto-login: Automatically login the software without user account validation. 

Prioritize the playback of record 

files on storage server 

Enable record files on storage server priority during playback 

operation.  

Resume Live View Status Enable resume review option 

Auto Time Adjustment Set the time auto adjust time  
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To finish general settings, you can click  button to save the changes or click “Default” to restore the default 

settings. 

7.2 File Saving Path Configuration 

In the File configuration tab, you can set the saving paths to store video files, captured pictures and configuration files.  

Steps: 

1. Click each  button to select the saving paths respectively for .video files, pictures and configuration files.   

2. Click   button to save the new settings, or click “Default” to restore default settings. 

 

7.3 Alarm Sound Configuration 

In the Alarm Sound configuration interface, you can configure audio (.wav) files for alarms of motion detections, video 

exceptions, alarm inputs and device exceptions.  

Steps: 
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1. Click each  button to open the file browser, and select an audio (.wav) file for the selected alarm type.  

2. Click the  button to listen to the selected audio file. 

3. Click   button to save the new settings, or click “Default” to restore default settings. 

 
 

7.4 Email Configuration 

In the email configuration interface, you can set the SMTP server, and account information for the alarm actions of the client.  

Steps: 

1. Enter SMTP server, Port, User Name, Password, Sender’s Address and Receiver’s Address. 

2. Click “Send Test Email” to check email configured successfully.  

3. Click button to save the new settings, or click “Default” to restore default settings. 
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Chapter 8. FAQ 

 

Live View 

Symptom:   

Failed to get the live view of a certain device 

Possible Reasons: 

Unstable network or the network performance is not good enough. The device is offline. 

Too many accesses to the remote device cause the load of the device too high. 

The current user has no permission for live view. 

The version of the client software is below the needed version. 

Troubleshooting: 

Check network status and disable other not in use process on your PC. 

Check the device network status. 

Restart the device or disable other remote access to the device.  

Log in with the admin user and try again. 

Download the client software of the newest version.  

Recording 

Symptom: 

Normal recording and the remote recording are confusing. 

Troubleshooting: 

When we say local recording when we use the client software, it refers to the recording on the PC running the client. 

And remote recording refers to the recording action commanded by the client on the device side, which stores the record files 

in the HDD of the device. 

 

Playback 

Symptom: 

Failed to download the playback file or the downloading speed is too slow.  

Possible Reasons: 

Unstable network or the network performance is not good enough. 

The NIC type is not compatible. 

Too many accesses to the remote device 

The current user has no permission for playback. 

The version of the client software is below the needed version. 

Troubleshooting: 

Check network status and disable other not in use process on your PC. 
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Directly connect the PC running the client to the device to check the compatibility of the NIC card. 

Restart the device or disable other remote access to the device.  

Log in with the admin user and try again. 

Download the client software of the newest version.  
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